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Experiment HM-2: Electromyogram (EMG) Activity in Antagonistic Muscles

Background

The movement of parts of the body is accomplished through a system of levers composed of skeletal 

muscles and bones. In a lever, the muscle attached to the bone provides the effort or force that moves 

the bone. As the muscle contracts and relaxes, the bone, functioning as the actual lever, rotates around a 

joint in the skeletal system. In relation to the muscle, the bone, and the body part being moved, the joint 

is the fixed point that functions as the fulcrum for the lever. The body part being moved is the load in 

the lever (Figure HM-2-B1). 

Figure HM-2-B1: A Third Class lever and a counterpart in the human body. The insertion of the 

muscle on the bone in the forearm places the effort between the elbow (fulcrum) and the hand (load).

All levers, including the ones in the body, can be categorized into one of three classes, which are based 

on the position of the fulcrum in relation to the positions of the effort and the load:

• In First Class levers, the fulcrum is between the effort and the load, like on a see-saw. In 

the body, an example of this class is the extension of the forearm by the triceps muscle. 

• In Second Class levers, the load is between the effort and the fulcrum, like a wheel 

barrow. In the body, an example of this class is standing on tiptoe by using the 

gastrocnemius muscle.

• In Third Class levers, the effort is between the fulcrum and the load, like tweezers. In the 

body, an example is the flexion of the forearm by the biceps muscle.

Body parts are moved in different directions by muscles that act on the same bone from different 

directions. A simple example is the movement of the forearm. When the biceps muscle contracts, the 

forearm and the hand move toward the shoulder in a motion called flexion. When the triceps muscle 

contracts, the forearm and hand move away from the shoulder in a motion called extension. Since these 

two muscles move the forearm in different directions, they are antagonistic muscles. These muscles 

relax and contract in a coordinated manner to place the forearm and hand in the desired position. If the 

effort exerted on the bone by each muscle is equal in magnitude and opposite in direction, the forearm 

remains stationary. Antagonistic muscles do not need to belong to the same class of lever to work in 

opposition. For example, the biceps and from two different classes of levers. The biceps and triceps are 

different classes of levers; the biceps is part of a third class lever, and the triceps is part of a first class 

lever.

By recording the EMG activity in a muscle during the movement or positioning of a body part, it can 

be determined if the muscle is involved. In this experiment, students will record EMG activity from 

muscles on the anterior and posterior sides of the forearm to determine which ones are responsible for 
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flexion and extension of the hand. Recording of EMG activity from these muscles will also be done 

while a weight is lifted by the hand. In another exercise, students will record EMG activity from the 

anterior and posterior sides of the lower leg to determine which muscles are active during movements 

or positioning that are more complex, like leaning forward, standing on toes, or rocking on heels. 
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Experiment HM-2: Electromyogram (EMG) Activity in Antagonistic Muscles

Equipment Required

PC or Mac Computer

IXTA data acquisition unit

USB cable

IXTA power supply

C-ISO-B3G ECG cable and electrode lead wires

Disposable electrodes

Alcohol swabs

Small weight

IXTA Setup

1. Place the IXTA on the bench, close to the computer.

2. Check Figure T-1-1 in the Tutorial Chapter for the location of the USB port and the power 

socket on the IXTA.

3. Check Figure T-1-2 in the Tutorial Chapter for a picture of the IXTA power supply.

4. Use the USB cable to connect the computer to the USB port on the rear panel of the IXTA. 

5. Plug the power supply for the IXTA into the electrical outlet. Insert the plug on the end of the 

power supply cable into the socket on the rear of the IXTA. Use the power switch to turn on the 

unit. Confirm that the power light is on.

Start the Software

1. Click on the LabScribe shortcut on the computer’s desktop to open the program. If a shortcut is 

not available, click on the Windows Start menu, move the cursor to All Programs and then to 

the listing for iWorx. Select LabScribe from the iWorx submenu. The LabScribe Main window 

will appear as the program opens.

2. On the Main window, pull down the Settings menu and select Load Group.

3. Locate the folder that contains the settings group, IPLMv4Complete.iwxgrp. Select this group 

and click Open.

4. Pull down the Settings menu again. Select the AntagonisticMuscles-LS2 settings file from 

Human Muscle.

5. After a short time, LabScribe will appear on the computer screen as configured by the 

AntagonisticMuscles-LS2 settings.

6. For your information, the settings used to configure the LabScribe software and the IXTA unit 

for this experiment are programmed on the Preferences Dialog window which can be viewed by 

selecting Preferences from the Edit menu on the LabScribe Main window.
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7. Once the settings file has been loaded, click the Experiment button on the toolbar to open any 

of the following documents:

• Appendix

• Background

• Labs

• Setup (opens automatically)

EMG Cable Setup

1. Locate the C-ISO-B3G EMG cable and electrode lead wires (Figure HM-2-S1) in the iWorx kit.

Figure HM-2-S1: The C-ISO-B3G EMG cable with five lead wires attached.

2. Insert the connector on the end of the EMG cable into the iWire 1 inputs on the front of the 

IXTA (Figure HM-2-S2).

3. Locate the muscles of the forearm over which the recording electrodes will be placed. Muscles 

can be located by flexing or extending the hand and noting the areas of the forearm where the 

muscles are tense during these hand positions:

• One pair of recording electrodes will be placed over the flexor muscles on the anterior 

surface of the forearm. The first electrode in this pair will be placed about 8 centimeters 

below the inside of the elbow and about 4 centimeters from the medial margin of the 

forearm. The second electrode in this pair will be placed about 8 centimeters below the 

other electrode along the midline of the anterior surface of the forearm.

• A second pair of electrodes will be placed over the extensor muscles on the posterior 

surface of the forearm. The first electrode in this pair will be placed about 9 centimeters 

below the tip of the elbow along the midline of the posterior surface of the forearm. The 

second electrode in this pair will be placed about 6 centimeters below the first electrode 

and about 3 centimeters from the lateral margin of the posterior surface of the forearm.

• A fifth electrode, used as the ground, is centered between the positions of the four 

recording electrodes.
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4. Use an alcohol swab to clean and scrub the areas where the electrodes will be placed (Figure 

HM-2-S3). Let the areas dry before attaching the electrodes.

Figure HM-2-S2: A five lead EMG cable connected to an IXTA.

Figure HM-2-S3: Position of electrodes used to record EMG from muscles in the forearm during 

flexion and extension.

5. Remove the plastic disk from a disposable electrode and apply it to one of the scrubbed areas. 

Attach an electrode to each of the other areas.

6. Snap the recording lead wires onto the electrodes, so that:

• the red “+1” lead is attached to the electrode on the anterior forearm that is nearest the 

elbow.

• the black “-1” lead is attached to the electrode on the anterior forearm closest to the 

middle of the forearm.
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• the white “+2” lead is attached to the electrode on the posterior forearm that is nearest 

the elbow.

• the brown “-2” lead is attached to the electrode on the posterior forearm closest to the 

middle of the forearm.

• the green “C” lead (the ground) is attached to the electrode in the center of the box 

formed by the positions of the four recording electrodes.
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Experiment HM-2: Electromyogram (EMG) Activity in Antagonistic Muscles

Exercise 1: Antagonistic Muscles in Forearm

Aim: To study the EMG activity in muscles that work in opposition to each other to flex or extend the 

hand.

Procedure

1. Instruct the subject that he or she will be doing the following during this exercise:

• Before the recording begins, the subject extends his or her arm in front of their body 

with the palm facing upward. This position is defined as the neutral position. 

• Keep his or her hand open during the recording.

• Move his or her hand upward (flexion) from the neutral position as far as possible and 

hold it in this position for four seconds (Figure HM-L1).

Figure HM-2-L1: Movements performed while recording from muscles of the forearm responsible for 

flexion and extension of the hand.

• Return the hand to the neutral position for four seconds.

• Move the hand downward (extension) as far as possible and hold it in this position for 

four seconds.

• Return the hand to the neutral position for at least wo seconds.

• Repeat this cycle of flexion and extension two more times while recording.

2. Before the starting the recording, type Neutral in the Mark box to the right of the Mark button. 

Instruct the subject to place his or her hand in the neutral position.

3. Click the Record button in the upper right corner of the LabScribe Main window. Either click 

on the Mark button or press the Enter key on the keyboard to label the recording.

4. While the subject’s hand is in the neutral position, type Flexion in the Mark box. When the 

subject flexes his or her hand, click on the Mark button or press the Enter key on the keyboard 

to label the recording.
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5. While the subject’s hand is in the flexed position, type Neutral in the Mark box. When the 

subject returns his or her hand to the neutral position, click on the Mark button or press the 

Enter key on the keyboard to label the recording.

6. While the subject’s hand is in the neutral position, type Extension in the Mark box. When the 

subject extends his or her hand, click on the Mark button or press the Enter key on the keyboard 

to label the recording.

7. Repeat Steps 2 through 6 two more times.

8. Repeat Steps 2 through 6 three times while the subject has formed a fist.

9. When the last cycle is completed, click the Stop button.

10.  Click AutoScale on all channels to amplify signals. The recording should be similar to Figure 

HM-2-L2.

11. Select Save As in the File menu, type a name for the file. Choose a destination on the computer 

in which to save the file, like your lab group folder). Designate the file type as *.iwxdata. Click 

on the Save button to save the data file. 

Figure HM-2-L2: Recordings from anterior (top) and posterior (bottom) muscles of the forearm during 

flexion and extension of the hand while the subject’s fingers are extended.

Data Analysis

1. Scroll through the recording and find the section of data recorded while the subject was flexing 

and extending his or her hand.

2. Use the Display Time icons to adjust the Display Time of the Main window so all three flexion-

extension cycles appear on the Main window. The three flexion-extension cycles can also be 

selected by:

• Placing the cursors on either side of the three adjacent cycles; and

• Clicking the Zoom between Cursors button on the LabScribe toolbar to expand the 

segment with the three cycles to the width of the Main window.
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3. Click on the Analysis window icon in the LabScribe toolbar (Figure HM-2-L3) or select 

Analysis from the Windows menu to transfer the data displayed in the Main window to the 

Analysis window (Figure HM-2-L4).

Figure HM-2-L3: The LabScribe toolbar.

4. Look at the Function Table that is above the uppermost channel displayed in the Analysis 

window. The mathematical functions, Abs. Int., Max-Min, and T2-T1 should appear in this 

table. The values for Abs. Int., Max-Min, and T2-T1 on each channel are seen in the table 

across the top margin of each channel.

Figure HM-2-L4: EMG activity from opposing muscles. Cursors are placed to measure the EMG 

activity taking place simultaneously in flexors and extensors.

5. Once the cursors are placed in the correct positions for measuring the three parameters of an 

EMG burst, the values for the parameters can be recorded in the on-line notebook of LabScribe 

by typing the names and values directly into the Journal, or on a data table.

6. The functions in the channel pull-down menus of the Analysis window can also be used to enter 

the names and values of the parameters to the Journal. To use these functions:
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• Place the cursors at the locations used to measure the absolute integrals.

• Transfer the name of the mathematical function used to determine the absolute integrals 

to the Journal using the Add Title to Journal function in the Anterior Channel pull-down 

menu.

• Transfer the values for the absolute integrals to the Journal using the Add All Data to 

Journal function in the Anterior Channel pull-down menu.

7. Use the mouse to click on and drag the cursors to the onset and offset of the EMG burst during 

the first flexion (Figure HM-2-L4). The values for Abs. Int., Max-Min, and T2-T1 on the 

Anterior channel are the relative amounts of the EMG activity, the differences between 

maximum and minimum EMG amplitudes, and the durations of the EMG burst in the anterior 

muscle group during the flexion. The values for these parameters, listed in the table above the 

Posterior channel, are the same properties from the posterior muscle group during the same 

flexion.

8. Record the values from each muscle group during the first flexion in the Journal, or on a data 

table

9. Use the mouse to move the cursors to onset and offset of the next EMG burst, which is the first 

burst that occurs during extension. Measure and record the values for Abs. Int., Max-Min, and 

T2-T1 from both groups of muscles during this extension. 

10. Measure the Abs.Int, Max-Min, and T2-T1 for the EMG bursts from the anterior and posterior 

muscles from the remaining flexions and extensions.

11. Average the values for each parameter taken from the anterior muscles during flexion. Find the 

average for each parameter from the anterior muscles during extension. Also, find the averages 

for the parameters from the posterior muscles during flexion and during extension. Enter the 

averages for each parameter, from each muscle group during flexion and during extension, on 

Table HM-2-L1.

12. Select Save from the File menu. 

Questions

1. Which muscles, anterior or posterior, had the most EMG activity during flexion?

2. Which muscles, anterior or posterior, had the most EMG activity during extension?

3. Does flexion or extension of the fingers affect the strength of EMG activity in either group of 

muscles?

Exercise 2: Antagonistic Muscles Doing Work

Aim: To study the EMG activity in muscles that lift weight by flexion or by extension.

Procedure

1. Use the same experimental setup used in Exercise 1.
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2. Instruct the subject to rest his or her forearm, with the electrodes, on a flat surface with the palm 

up.

3. Place a weight (2-3kg) in the palm of the subject’s hand (Figure HM-2-L5). Click Record. 

Record the EMG activity from the muscles of the forearm as the subject lifts the weight by the 

flexion. The subject should raise and hold the weight up for four seconds and then return the 

weight to the table top for four seconds. Repeat this cycle two more times.

4. Click Stop to halt the recording.

Figure HM-2-L5: Hand in the palm-up position for lifting the weight by flexion (on the left), and the 

hand in the palm-down position for lifting the weight by extension (on the right).

5. Instruct the subject to rest his or her forearm on a flat surface with the palm down (Figure HM-

2-L5).

6. Have the subject grip the same weight (2-3kg).

7. Click Record. Record the EMG activity from the muscles of the forearm as the subject lifts the 

weight by extension. The subject should raise and hold the weight up for four seconds and then 

return the weight to the table top for four seconds. Repeat this cycle two more times. 

8. Click Stop to halt the recording.

9. Select Save in the File menu.

Data Analysis

1. Scroll through the recording and find the section of data recorded while the subject was lifting a 

weight by flexion and extension.

2. Use the same procedures used in Exercise 1 to measure and record the Abs. Int., Max-Min, and 

T2-T1 from each muscle group while the weight was lifted by flexion and by extension.

3. Average the values for each parameter taken from the anterior muscles while weight was lifted 

by flexion. Find the average for each parameter from the anterior muscles while weight was 

lifted by flexion. Also, find the averages for the parameters from the posterior muscles while 

weight was lifted by flexion and by extension. Enter the means for each parameter, from each 

muscle group during flexion and during extension, on Table HM-2-L1.

4. Select Save from the File menu.
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Questions

1. Does the strength of the EMG activity in the muscles of the anterior forearm differ between 

flexion with a weight and without a weight?

2. Does the strength of the EMG activity in the muscles of the posterior forearm differ between 

extension with a weight and without a weight?. 

Table HM-2-L1: Relative EMG Activity in the Muscles of the Forearm during Flexion and 

Extension.

Averages from Anterior Muscles Averages from Posterior Muscles

Forearm Action Abs.Int.
V2-V1 

(V)

T2-T1 

(sec)
Abs.Int.

V2-V1 

(V)
T2-T1 (sec)

Flexion, Hand Open

Extension, Hand Open 

Flexion, Hand Closed

Extension, Hand Closed

Flexion, Lifting Weight

Extension, Lifting 

Weight

Exercise 3: Antagonistic Muscles in Lower Leg

Aim: To study muscles working in opposition to each other to maintain balance while standing.

Procedure

1. Locate the muscles of the lower leg over which the recording electrodes will be attached. 

Muscles can be located by performing dorsiflexion (lifting the toes towards the shin), or plantar 

flexion (pointing the toes toward the ground), and noting the areas of the lower leg where the 

muscles are tense during each flexion:

• One pair of recording electrodes will be placed over the anterior tibialis muscle. This 

muscle is located just lateral to the tibia (shinbone) in the upper part of the calf (Figure 

HM-2-L6). To locate the tibialis anterior, feel for the subject's tibia. Place your fingers 2 

cm to the lateral side of the margin of the tibia and 8-12 cm below the kneecap. As the 

subject points his or her foot inward (supination) and upward (dorsiflexion) their foot, 

you should be able to see and feel the contraction of the anterior tibialis muscle beneath 

the skin. The first electrode in this pair will be placed about 10 centimeters below the 

knee on the midline of the muscle. The second electrode in this pair will be placed on the 

midline of the muscle, about 10 centimeters below the first electrode.
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• A second pair of recording electrodes will be placed over the gastrocnemius (calf) 

muscle on the back of the lower leg. The first electrode in this pair will be placed about 

8 centimeters below the back of the knee, along the midline of the calf muscle. The 

second electrode in this pair will be placed in the middle of the calf muscle along its 

midline, about 10 centimeters below the first electrode.

• A fifth electrode, used as the ground, is placed on the inside of the lower leg just above 

the ankle. 

2. Use an alcohol swab to clean and scrub the areas where the electrodes will be placed (Figure 

HM-2-L6). Let the iareas dry before attaching the electrodes.

3. Remove the plastic disk from a disposable electrode and apply it to one of the scrubbed areas. 

4. Snap the recording lead wires onto the electrodes, so that:

• the red “+1” lead is placed on the electrode in the upper portion of the tibialis anterior.

• the black “-1” lead is placed on the electrode in the middle portion of the tibialis 

anterior.

• the white “+2” lead is attached to the electrode near the back of the knee.

• the brown “-2” lead is attached to the electrode in the middle of the calf muscle. 

• the green “C” lead (the ground) is attached to the electrode above the ankle.

5. While the subject is sitting, click Record. Have the subject alternate between plantar flexion and 

dorsiflexion of their foot. Click AutoScale on all channels to amplify signals. Use the 

techniques explained in Exercise 1 to mark the recording with comments that identify the EMG 

activity associated with plantar flexion and dorsiflexion.

6. Have the subject stand erect. Click Record. Have the subject rock on their feet from heels to 

toes and back to heels, 4 times. Mark the recording with comments that identify the EMG 

activity that took place.

7. Determine which muscle group, gastrocnemius or anterior tibialis muscles, contract when the 

subject rocks forward or rocks backward.

8. Have the subject rock backward and forward, 4 times, while putting more weight on the leg 

with the electrodes. Even though one muscle may dominate the record, the other muscle is also 

somewhat active. Mark the recording with comments that identify the EMG activity that took 

place.

9. Have the subject stand on one foot and remain motionless. Co-contraction of the antagonistic 

muscles mechanically stabilizes the joints when the subject is motionless. The stretch reflexes 

prevent twisting and slipping and help to maintain balance. Mark the recording with comments 

that identify the EMG activity that took place.
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Figure HM-2-L6: Position of electrodes used to record EMG from muscles in the lower leg during 

plantar flexion and dorsiflexion.

10. Joint stabilization is particularly important to leg and postural muscles involved in bipedal 

locomotion. Within the limits of artifacts induced by leg movement and cable lengths, explore 

the activity of the ankle flexors. Have the subject either squat or stretch upward on his/her toes. 

Mark the recording with comments that identify the EMG activity that took place. Click Stop to 

halt recording.

11. Select Save in the File menu.

Data Analysis

1. Scroll to the data where EMG activity was recorded from the muscles of the anterior and 

posterior lower leg.

2. Use the same procedures used in Exercise 1 to measure and record the absolute integral, 

difference in amplitudes, and durations of the EMG bursts from the anterior and posterior 

muscles of the lower leg while the subject moved his or her legs and body in different positions: 

• Standing erect on both legs;

• Rocking back and forth on both legs;

• Rocking back and forth on the leg with the electrodes;

• Standing erect on the leg with the electrodes;

• Ankle flexing by squatting or standing on the toes

3. Enter the means for each parameter, from each muscle group during the various motions, on 

Table HM-2-L2
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Questions

1. Compare the parameters for the EMG bursts from the tibialis anterior during each of the 

activities. When was tibialis anterior activity the greatest? The least?

2. Compare the parameters for the EMG bursts from the gastrocnemius during each of the 

activities. When was gastrocnemius activity the greatest? The least?

3. How does EMG activity in the gastrocnemius correlate to EMG activity in the tibialis anterior?

Table HM-2-L2: Relative EMG Activity in the Muscles of the Lower Leg during Changes in 

Posture.

Averages from Anterior Tibialis Averages from Gastrocnemius

Leg Activity Abs.Int.
V2-V1 

(V)

T2-T1 

(sec)
Abs.Int.

V2-V1 

(V)
T2-T1 (sec)

Standing Erect, Both Legs

Rocking Forward, Both 

Legs

Rocking Backward, Both 

Legs

Rocking Forward, One Leg

Rocking Backward, One 

Leg

Standing Erect, One Leg

Ankle Flex, Squat

Ankle Flex, Standing on 

Toes
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